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Introduction

In this example, a simplified micromechanical model of a particulate composite is analyzed. 
A representative volume element (RVE) based on a predetermined particle spacing is 
assumed to represent the microstructure of the composite. The homogenized elastic and 
viscoelastic properties of the composite material are computed based on the individual 
properties of the particles and the matrix. Transient analyses of shear and normal loading 
of the composite microstructure yield the viscoelastic response of the composite, which is 
used to determine the homogenized viscoelastic parameters using curve fitting 
optimization.

The following considerations are important for the analysis:

• In the particulate composite, only the matrix material is assumed to show viscoelastic 
behavior. This is a realistic assumption for, for example, polymer matrix composites. 
Polymer-like resin shows viscoelastic behavior, whereas the embedded fibers or particles 
are assumed to be elastic.

• The viscoelastic properties of the matrix in the heterogeneous material and in the 
equivalent homogenized material are assumed to be represented by a generalized 
Maxwell model, having a Prony series representation.

• The viscoelastic model of the matrix in the heterogeneous material as well as the model 
of the equivalent homogeneous material are isotropic.

• The viscoelastic model of the matrix material is deviatoric. In contrast, the viscoelastic 
model of the homogenized material can be volumetric as well as deviatoric due to the 
inclusion of the particles. When determining the homogenized viscoelastic parameters 
through an optimization routine, it is assumed that the relaxation times of the 
homogenized material are the same as those of the matrix material.

• To determine the homogenized, isotropic, viscoelastic parameters from the particulate 
composite, two different stress responses from a unit cell RVE are required:

- The shear stress response, which only activates the deviatoric part of the 
homogeneous, isotropic, viscoelastic model.

- The normal stress response, which activates both the deviatoric and the volumetric 
part of the homogeneous, isotropic, viscoelastic model.

• During step loading in the time-dependent study, both the instantaneous and the long-
term response of the heterogeneous RVE are purely elastic. They are therefore excluded 
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when determining the homogeneous, viscoelastic parameters through the optimization 
routine.

• In the current example, uniform spacing of particles is assumed in all three directions. 
However, it is also possible to perform micromechanical analyses for nonuniformly 
distributed particles.

Model Definition

The composite is assumed to be made of a periodic microstructure identified as a primitive 
cubic structure. A unit cube RVE having a spherical particle embedded in the center of the 
matrix is shown in Figure 1.

Figure 1: Geometry of the unit cell, consisting of a spherical particle embedded in epoxy resin.

Particle and Matrix Properties
The elastic material properties of particles and matrix are given in Table 1 and Table 2, 
respectively.

TABLE 1:  PARTICLE MATERIAL PROPERTIES.

Material Property Value

Ep 230 GPa

p 0.2

Particles

Matrix
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The relaxation function (t) in the viscoelastic model for the matrix is expressed in terms 
of the instantaneous shear modulus G0 and a set of N relative weights gk and relaxation 
times k, so that the Prony series is given as

where gk and k are the relative weight and the relaxation time constant of the spring-
dashpot pair in branch k, respectively. In this case, the long-term shear modulus G is 
related to the instantaneous shear modulus G0 by the weight g  

and the shear modulus in each branch k is defined by the weight gk

It must be assumed that the weights fulfill the constraint

The relative weights and relaxation time constants for the three branches are given in 
Table 3.

TABLE 2:  MATRIX MATERIAL PROPERTIES.

Material Property Value

Em 10 GPa

m 0.35

TABLE 3:  VISCOELASTIC PROPERTIES OF THE MATRIX.

Branch Relative Weight Relaxation Time 
Constant

1 0.01 0.01 s

2 0.05 0.1 s

3 0.08 1 s
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Results and Discussion

The von Mises stress in the constituents when viscoelasticity is neglected is shown in 
Figure 2 and Figure 3 for normal and shear loading, respectively. The corresponding 
results when viscoelasticity in the matrix is included are reported in Figure 4 and Figure 5 
for normal and shear loading, respectively. Here, the results are shown at the end of the 
simulation when the viscous branches are fully relaxed. Note that the stresses in the 
constituents are in good agreement with those computed in the elastic study, as expected.

The variation in average normal and shear stress with time for the heterogeneous RVE is 
shown in Figure 6. The initial response is elastic, which is followed by stress relaxation in 
the viscous branches.

The variations in average shear and normal stresses with time for the heterogeneous RVE 
and the homogenized, equivalent material are shown in Figure 7 and Figure 8, 
respectively. The relative weights for the deviatoric and volumetric parts obtained from the 
optimization routine are given in Table 4 and Table 5, respectively. It can be seen that the 
deviatoric relative weights for the homogenized material are close to those of the matrix 
due to the low particle volume fraction, which means that the viscoelastic response of the 
composite is dominated by the matrix viscoelasticity. Note, however, that the 
heterogeneity does result in nonzero volumetric relative weights.

TABLE 4:  HOMOGENIZED VISCOELASTIC DEVIATORIC PROPERTIES.

Branch Relative Weight Relaxation Time 
Constant

1 0.00942 0.01 s

2 0.04918 0.1 s

3 0.07934 1 s

TABLE 5:  HOMOGENIZED VISCOELASTIC VOLUMETRIC PROPERTIES.

Branch Relative Weight Relaxation Time 
Constant

1 6.516E-4 0.01 s

2 0.00436 0.1 s

3 0.00681 1 s
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Figure 2: von Mises stress in matrix and particle due to axial loading (elastic conditions).

Figure 3: von Mises stress in matrix and particle due to shear loading (elastic conditions).
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Figure 4: von Mises stress in particle and matrix under axial loading (viscoelasticity in 
matrix).
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Figure 5: von Mises stress in particle and matrix under shear loading (viscoelasticity in 
matrix).
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Figure 6: Average viscoelastic normal and shear stress in the heterogeneous RVE.

Figure 7: Average viscoelastic shear stress for the composite and the homogenized material.
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.

Figure 8: Average viscoelastic normal stress for the heterogeneous RVE and the equivalent 
homogenized material.

Notes About the COMSOL Implementation

• The micromechanical analysis of particles in a bulk matrix can be performed using the 
Cell Periodicity node available in the Solid Mechanics interface. Using this functionality, 
the elasticity matrix of the homogenized material can be computed for given particle 
and matrix properties.

• The Cell Periodicity node has three action buttons in the toolbar of the section called 
Periodicity Type: Create Load Groups and Study, Create Material by Value, and Create 

Material by Reference. The action button Create Load Groups and Study generates load 
groups and a stationary study with load cases. The action button Create Material by Value 
generates a Global Material with homogenized material properties, with material 
properties as numbers. The action button Create Material by Reference generates a Global 

Material with homogenized material properties, with material properties as variables. 
The action buttons are active depending on the choices in the Periodicity Type and 
Calculate Average Properties lists.

• The viscoelastic model of the matrix can be modeled using the Generalized Maxwell 
material model available in the Viscoelasticity feature.
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Application Library path: Structural_Mechanics_Module/Material_Models/
micromechanical_model_of_a_particulate_composite

Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 3D.

2 In the Select Physics tree, select Structural Mechanics>Solid Mechanics (solid).

3 Click Add.

4 Click Done.

G L O B A L  D E F I N I T I O N S

Geometric Properties
1 In the Model Builder window, under Global Definitions click Parameters 1.

2 In the Settings window for Parameters, type Geometric Properties in the Label text 
field.

3 Locate the Parameters section. In the table, enter the following settings:

Material Properties
1 In the Home toolbar, click Parameters and choose Add>Parameters.

2 In the Settings window for Parameters, type Material Properties in the Label text 
field.

3 Locate the Parameters section. Click Load from File.

Name Expression Value Description

para 0 0 Parameter

L 1[m] 1 m Unit cell length

dp 0.4[m] 0.4 m Particle diameter
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4 Browse to the model’s Application Libraries folder and double-click the file 
micromechanical_model_of_a_particulate_composite_material_properties

.txt.

5 In the Model Builder window, right-click Global Definitions and choose Geometry Parts>

Part Libraries.

P A R T  L I B R A R I E S

1 In the Part Libraries window, select COMSOL Multiphysics>

Representative Volume Elements>3D>particulate_primitive_cubic in the tree.

2 Right-click Global Definitions and choose Add to Model.

3 In the Select Part Variant dialog box, select Specify particle diameter in the 
Select part variant list.

4 Click OK.

Create one RVE geometry for the heterogeneous material and one for the homogenized 
material.

G E O M E T R Y  1

Heterogeneous RVE
1 In the Geometry toolbar, click Parts and choose Particulate Composite,

Primitive Cubic.

2 In the Settings window for Part Instance, type Heterogeneous RVE in the Label text 
field.

To define the RVE geometry, enter the geometric properties in the input parameters of 
the part.

3 Locate the Input Parameters section. In the table, enter the following settings:

Homogeneous RVE
1 In the Geometry toolbar, click Block.

2 In the Settings window for Block, type Homogeneous RVE in the Label text field.

Name Expression Value Description

dp dp 0.4 m Particle diameter

wm L 1 m Width of RVE

dm L 1 m Depth of RVE

hm L 1 m Height of RVE
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3 Locate the Size and Shape section. In the Width text field, type L.

4 In the Depth text field, type L.

5 In the Height text field, type L.

6 Locate the Position section. In the x text field, type 2*L.

7 Click Build Selected.

M A T E R I A L S

Matrix
1 In the Model Builder window, under Component 1 (comp1) right-click Materials and 

choose Blank Material.

2 In the Settings window for Material, type Matrix in the Label text field.

3 Locate the Geometric Entity Selection section. From the Selection list, choose 
Matrix (Heterogeneous RVE).

4 Locate the Material Contents section. In the table, enter the following settings:

Particulates
1 Right-click Materials and choose Blank Material.

2 In the Settings window for Material, type Particulates in the Label text field.

3 Locate the Geometric Entity Selection section. From the Selection list, choose 
Particle (Heterogeneous RVE).

4 Locate the Material Contents section. In the table, enter the following settings:

First, set up the Solid Mechanics interface to compute the homogenized elastic properties.

Set the structural transient behavior to quasistatic as the inertial response is of no interest.

Property Variable Value Unit Property group

Young’s modulus E E_m Pa Young’s modulus and 
Poisson’s ratio

Poisson’s ratio nu nu_m 1 Young’s modulus and 
Poisson’s ratio

Property Variable Value Unit Property group

Young’s modulus E E_p Pa Young’s modulus and 
Poisson’s ratio

Poisson’s ratio nu nu_p 1 Young’s modulus and 
Poisson’s ratio
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S O L I D  M E C H A N I C S :  H E T E R O G E N E O U S  R V E

1 In the Model Builder window, under Component 1 (comp1) click Solid Mechanics (solid).

2 In the Settings window for Solid Mechanics, type Solid Mechanics: Heterogeneous 
RVE in the Label text field.

3 Locate the Domain Selection section. From the Selection list, choose 
All (Heterogeneous RVE).

4 Locate the Structural Transient Behavior section. From the list, choose Quasistatic.

Linear Elastic Material 1
Use reduced integration to speed up the simulation.

1 In the Model Builder window, under Component 1 (comp1)>

Solid Mechanics: Heterogeneous RVE (solid) click Linear Elastic Material 1.

2 In the Settings window for Linear Elastic Material, locate the Quadrature Settings section.

3 Select the Reduced integration check box.

Cell Periodicity for Elastic Properties
1 In the Physics toolbar, click Domains and choose Cell Periodicity.

2 In the Settings window for Cell Periodicity, type Cell Periodicity for Elastic 
Properties in the Label text field.

3 Locate the Periodicity Type section. From the list, choose Average strain.

4 From the Calculate average properties list, choose Elasticity matrix, Standard (XX, YY, ZZ,

XY, YZ, XZ).

Boundary Pair 1
1 In the Physics toolbar, click Attributes and choose Boundary Pair.

2 In the Settings window for Boundary Pair, locate the Boundary Selection section.

3 Click Clear Selection.

4 From the Selection list, choose Pair 1 (Heterogeneous RVE).

Boundary Pair 2
1 Right-click Boundary Pair 1 and choose Duplicate.

2 In the Settings window for Boundary Pair, locate the Boundary Selection section.

3 Click Clear Selection.

4 From the Selection list, choose Pair 2 (Heterogeneous RVE).

Boundary Pair 3
1 Right-click Boundary Pair 2 and choose Duplicate.
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2 In the Settings window for Boundary Pair, locate the Boundary Selection section.

3 Click Clear Selection.

4 From the Selection list, choose Pair 3 (Heterogeneous RVE).

Cell Periodicity for Elastic Properties
With the Average strain option in the Cell Periodicity feature, appropriate load groups, a 
study, and a material with computed elastic properties can be generated automatically.

1 In the Model Builder window, click Cell Periodicity for Elastic Properties.

2 In the Settings window for Cell Periodicity, click Study and Material Generation in the 
upper-right corner of the Periodicity Type section. From the menu, choose 
Create Load Groups and Study.

M E S H  1

Free Triangular 1
1 In the Mesh toolbar, click Boundary and choose Free Triangular.

2 Select Boundaries 1–3 only.

Size 1
1 Right-click Free Triangular 1 and choose Size.

2 In the Settings window for Size, locate the Geometric Entity Selection section.

3 From the Geometric entity level list, choose Entire geometry.

4 Locate the Element Size section. From the Predefined list, choose Finer.

5 Click the Custom button.

6 Locate the Element Size Parameters section. Select the Maximum element size check box.

7 Select the Minimum element size check box.

8 Select the Maximum element growth rate check box.

9 Select the Curvature factor check box.

10 Select the Resolution of narrow regions check box.

11 Click Build Selected.

Free Triangular 2
1 In the Mesh toolbar, click Boundary and choose Free Triangular.

2 Select Boundaries 6–13 only.

Size 1
1 Right-click Free Triangular 2 and choose Size.
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2 In the Settings window for Size, locate the Geometric Entity Selection section.

3 From the Geometric entity level list, choose Entire geometry.

4 Locate the Element Size section. From the Predefined list, choose Fine.

5 Click the Custom button.

6 Locate the Element Size Parameters section.

7 Select the Maximum element size check box. In the associated text field, type 0.07.

8 Select the Minimum element size check box. In the associated text field, type 0.05.

9 Select the Maximum element growth rate check box.

10 Select the Curvature factor check box.

11 Select the Resolution of narrow regions check box.

12 Click Build Selected.

Copy Face 1
1 In the Mesh toolbar, click Copy and choose Copy Face.

2 In the Settings window for Copy Face, locate the Source Boundaries section.

3 From the Selection list, choose Pair 1, Source (Heterogeneous RVE).

4 Locate the Destination Boundaries section. Click to select the Activate Selection 
toggle button.

5 From the Selection list, choose Pair 1, Destination (Heterogeneous RVE).

6 Click Build Selected.

Copy Face 2
1 In the Mesh toolbar, click Copy and choose Copy Face.

2 In the Settings window for Copy Face, locate the Source Boundaries section.

3 From the Selection list, choose Pair 2, Source (Heterogeneous RVE).

4 Locate the Destination Boundaries section. Click to select the Activate Selection 
toggle button.

5 From the Selection list, choose Pair 2, Destination (Heterogeneous RVE).

6 Click Build Selected.

Copy Face 3
1 In the Mesh toolbar, click Copy and choose Copy Face.

2 In the Settings window for Copy Face, locate the Source Boundaries section.

3 From the Selection list, choose Pair 3, Source (Heterogeneous RVE).
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4 Locate the Destination Boundaries section. Click to select the Activate Selection 
toggle button.

5 From the Selection list, choose Pair 3, Destination (Heterogeneous RVE).

6 Click Build Selected.

Free Tetrahedral 1
1 In the Mesh toolbar, click Free Tetrahedral.

2 In the Settings window for Free Tetrahedral, locate the Domain Selection section.

3 From the Geometric entity level list, choose Domain.

4 From the Selection list, choose All (Heterogeneous RVE).

Size 1
1 Right-click Free Tetrahedral 1 and choose Size.

2 In the Settings window for Size, locate the Geometric Entity Selection section.

3 From the Geometric entity level list, choose Entire geometry.

4 Locate the Element Size section. From the Predefined list, choose Normal.

5 Click the Custom button.

6 Locate the Element Size Parameters section. Select the Maximum element size check box.

7 Select the Minimum element size check box.

8 Select the Maximum element growth rate check box.

9 Select the Curvature factor check box. In the associated text field, type 0.4.

10 Select the Resolution of narrow regions check box.

11 Click Build All.

Mapped 1
1 In the Mesh toolbar, click Boundary and choose Mapped.

2 Select Boundary 15 only.

Distribution 1
1 Right-click Mapped 1 and choose Distribution.

2 Select Edges 28 and 30 only.

3 In the Settings window for Distribution, locate the Distribution section.

4 In the Number of elements text field, type 1.

Swept 1
1 In the Mesh toolbar, click Swept.
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2 In the Settings window for Swept, locate the Domain Selection section.

3 From the Geometric entity level list, choose Domain.

4 Select Domain 3 only.

Distribution 1
1 Right-click Swept 1 and choose Distribution.

2 In the Settings window for Distribution, locate the Distribution section.

3 In the Number of elements text field, type 1.

4 Click Build All.

C E L L  P E R I O D I C I T Y  S T U D Y  F O R  E L A S T I C  P R O P E R T I E S  ( H E T E R O G E N E O U S  

R V E )

1 In the Model Builder window, click Cell Periodicity Study.

2 In the Settings window for Study, type Cell Periodicity Study for Elastic 
Properties (Heterogeneous RVE) in the Label text field.

3 In the Home toolbar, click Compute.

R E S U L T S

Stress, Elastic Response
1 In the Model Builder window, under Results click Stress (solid).

2 In the Settings window for 3D Plot Group, type Stress, Elastic Response in the 
Label text field.

3 Click to expand the Selection section. From the Geometric entity level list, choose 
Domain.

4 From the Selection list, choose All (Heterogeneous RVE).

5 Select the Apply to dataset edges check box.

6 Click to expand the Title section. From the Title type list, choose Manual.

7 In the Title text area, type von Mises stress (MPa) .

8 Locate the Plot Settings section. Clear the Plot dataset edges check box.

9 Click to expand the Plot Array section. Select the Enable check box.

Volume 1
1 In the Model Builder window, expand the Stress, Elastic Response node, then click 

Volume 1.

2 In the Settings window for Volume, locate the Expression section.
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3 From the Unit list, choose MPa.

Selection 1
1 Right-click Volume 1 and choose Selection.

2 In the Settings window for Selection, locate the Selection section.

3 From the Selection list, choose Matrix (Heterogeneous RVE).

Deformation
In the Model Builder window, under Results>Stress, Elastic Response>Volume 1 right-click 
Deformation and choose Delete.

Volume 2
1 In the Model Builder window, under Results>Stress, Elastic Response right-click Volume 1 

and choose Duplicate.

2 In the Settings window for Volume, click to expand the Inherit Style section.

3 From the Plot list, choose Volume 1.

4 Click to expand the Plot Array section. Clear the Apply to dataset edges check box.

Selection 1
1 In the Model Builder window, expand the Volume 2 node, then click Selection 1.

2 In the Settings window for Selection, locate the Selection section.

3 Click Clear Selection.

4 From the Selection list, choose Particle (Heterogeneous RVE).

Stress, Elastic Response
Click the Go to Default View button in the Graphics toolbar.

Before you set up the physics to analyze the viscoelastic response, create a homogenized 
material from the Cell Periodicity feature.

The homogenized material can be created by using either of the two action buttons in the 
Periodicity type section, Create Material by Reference or Create Material by Value. Choose 
the second action button in order to generate a material with numbers.

S O L I D  M E C H A N I C S :  H E T E R O G E N E O U S  R V E  ( S O L I D )

Cell Periodicity for Elastic Properties
1 In the Model Builder window, under Component 1 (comp1)>

Solid Mechanics: Heterogeneous RVE (solid) click Cell Periodicity for Elastic Properties.
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2 In the Settings window for Cell Periodicity, click Study and Material Generation in the 
upper-right corner of the Periodicity Type section. From the menu, choose 
Create Material by Value to generate a global material node with the computed elastic 
properties.

Set up the physics interface to analyze the viscoelastic response of the composite.

G L O B A L  D E F I N I T I O N S

Step 1 (step1)
1 In the Home toolbar, click Functions and choose Global>Step.

2 In the Settings window for Step, type strainFunction in the Function name text field.

3 Locate the Parameters section. In the Location text field, type 5e-4[s].

4 Click to expand the Smoothing section. In the Size of transition zone text field, type 1e-
3[s].

D E F I N I T I O N S

Variables: Heterogeneous RVE
1 In the Model Builder window, under Component 1 (comp1) right-click Definitions and 

choose Variables.

2 In the Settings window for Variables, type Variables: Heterogeneous RVE in the 
Label text field.

3 Locate the Variables section. In the table, enter the following settings:

S O L I D  M E C H A N I C S :  H E T E R O G E N E O U S  R V E  ( S O L I D )

Linear Elastic Material 1
In the Model Builder window, under Component 1 (comp1)>

Solid Mechanics: Heterogeneous RVE (solid) click Linear Elastic Material 1.

Viscoelasticity 1
1 In the Physics toolbar, click Attributes and choose Viscoelasticity.

2 In the Settings window for Viscoelasticity, locate the Domain Selection section.

Name Expression Unit Description

G_m E_m/(2*(1+nu_m)) Pa Shear modulus of matrix

sum_g g1+g2+g3 Sum of weights

G_m0 G_m/(1-sum_g) Pa Instantaneous shear 
modulus of matrix
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3 From the Selection list, choose Matrix (Heterogeneous RVE).

4 Locate the Viscoelasticity Model section. In the table, enter the following settings:

5 Click Add.

6 In the table, enter the following settings:

7 Click Add.

8 In the table, enter the following settings:

Cell Periodicity for Viscoelastic Properties
1 In the Model Builder window, right-click Cell Periodicity for Elastic Properties and choose 

Duplicate.

2 In the Settings window for Cell Periodicity, type Cell Periodicity for 
Viscoelastic Properties in the Label text field.

3 Locate the Periodicity Type section. From the Calculate average properties list, choose 
None.

4 In the avg table, enter the following settings:

A D D  S T U D Y

1 In the Home toolbar, click Add Study to open the Add Study window.

2 Go to the Add Study window.

3 Find the Studies subsection. In the Select Study tree, select General Studies>

Time Dependent.

4 Click Add Study in the window toolbar.

Branch Shear modulus (Pa) Relaxation time (s)

1 G_m0*g1 Tau1

Branch Shear modulus (Pa) Relaxation time (s)

2 G_m0*g2 Tau2

Branch Shear modulus (Pa) Relaxation time (s)

3 G_m0*g3 Tau3

(para==1)*strainFunction(t) (para==2)*0.5*
strainFunction(t)

0

(para==2)*0.5*strainFunction(t) 0 0

0 0 0
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5 In the Home toolbar, click Add Study to close the Add Study window.

T R A N S I E N T  S T U D Y  F O R  V I S C O E L A S T I C  R E S P O N S E  ( H E T E R O G E N E O U S  R V E )

1 In the Model Builder window, click Study 1.

2 In the Settings window for Study, type Transient Study for Viscoelastic 
Response (Heterogeneous RVE) in the Label text field.

Parametric Sweep
1 In the Study toolbar, click Parametric Sweep.

2 In the Settings window for Parametric Sweep, locate the Study Settings section.

3 Click Add.

4 In the table, enter the following settings:

Step 1: Time Dependent
1 In the Model Builder window, click Step 1: Time Dependent.

2 In the Settings window for Time Dependent, locate the Study Settings section.

3 In the Output times text field, type range(0,0.5e-4,9.5e-4) 10^{range(-3,0.1,
1.5)}.

4 Locate the Physics and Variables Selection section. Select the 
Modify model configuration for study step check box.

5 In the tree, select Component 1 (comp1)>Solid Mechanics: Heterogeneous RVE (solid)>

Cell Periodicity for Elastic Properties.

6 Right-click and choose Disable.

Customize the solver settings by choosing a smaller initial time step for better 
convergence.

Solution 1 (sol1)
1 In the Study toolbar, click Show Default Solver.

2 In the Model Builder window, expand the Solution 1 (sol1) node, then click Time-

Dependent Solver 1.

3 In the Settings window for Time-Dependent Solver, click to expand the Time Stepping 
section.

4 Select the Initial step check box. In the associated text field, type 5e-7.

Parameter name Parameter value list Parameter unit

para (Parameter) range(1,1,2)
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5 In the Study toolbar, click Compute.

Visualize the stress in the composite when matrix viscoelasticity is activated.

R E S U L T S

Stress, Viscoelastic Response
1 In the Model Builder window, under Results click Stress (solid).

2 In the Settings window for 3D Plot Group, type Stress, Viscoelastic Response in 
the Label text field.

3 Click to expand the Selection section. From the Geometric entity level list, choose 
Domain.

4 From the Selection list, choose All (Heterogeneous RVE).

5 Select the Apply to dataset edges check box.

6 Locate the Title section. From the Title type list, choose Manual.

7 In the Title text area, type von Mises stress (MPa) .

8 Locate the Plot Settings section. Clear the Plot dataset edges check box.

9 Locate the Plot Array section. Select the Enable check box.

Volume 1
1 In the Model Builder window, expand the Stress, Viscoelastic Response node, then click 

Volume 1.

2 In the Settings window for Volume, locate the Expression section.

3 From the Unit list, choose MPa.

Selection 1
1 Right-click Volume 1 and choose Selection.

2 In the Settings window for Selection, locate the Selection section.

3 From the Selection list, choose Matrix (Heterogeneous RVE).

Deformation
In the Model Builder window, under Results>Stress, Viscoelastic Response>Volume 1 right-
click Deformation and choose Delete.

Volume 2
1 In the Model Builder window, under Results>Stress, Viscoelastic Response right-click 

Volume 1 and choose Duplicate.

2 In the Settings window for Volume, locate the Inherit Style section.
23 |  M I C R O M E C H A N I C A L  M O D E L  O F  A  P A R T I C U L A T E  C O M P O S I T E



3 From the Plot list, choose Volume 1.

4 Locate the Plot Array section. Clear the Apply to dataset edges check box.

Selection 1
1 In the Model Builder window, expand the Volume 2 node, then click Selection 1.

2 In the Settings window for Selection, locate the Selection section.

3 Click Clear Selection.

4 From the Selection list, choose Particle (Heterogeneous RVE).

Stress, Viscoelastic Response
Click the Go to Default View button in the Graphics toolbar.

Average Normal and Shear Stresses
1 In the Home toolbar, click Add Plot Group and choose 1D Plot Group.

2 In the Settings window for 1D Plot Group, type Average Normal and Shear Stresses 
in the Label text field.

3 Locate the Data section. From the Dataset list, choose 
Transient Study for Viscoelastic Response (Heterogeneous RVE)/

Parametric Solutions 1 (sol2).

4 Locate the Plot Settings section.

5 Select the y-axis label check box. In the associated text field, type Average stress (N/
m<sup>2</sup>).

6 Click to expand the Title section. From the Title type list, choose Manual.

7 In the Title text area, type Global: Average stress (N/m<sup>2</sup>) .

8 Locate the Axis section. Select the x-axis log scale check box.

9 Locate the Legend section. From the Position list, choose Lower right.

Global 1
1 Right-click Average Normal and Shear Stresses and choose Global.

2 In the Settings window for Global, locate the Data section.

3 From the Dataset list, choose 
Transient Study for Viscoelastic Response (Heterogeneous RVE)/

Parametric Solutions 1 (sol2).

4 From the Parameter selection (para) list, choose First.
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5 Locate the y-Axis Data section. In the table, enter the following settings:

6 Click to expand the Legends section. From the Legends list, choose Manual.

7 In the table, enter the following settings:

Global 2
1 Right-click Global 1 and choose Duplicate.

2 In the Settings window for Global, locate the Data section.

3 From the Parameter selection (para) list, choose Last.

4 Locate the y-Axis Data section. In the table, enter the following settings:

5 Locate the Legends section. In the table, enter the following settings:

6 In the Average Normal and Shear Stresses toolbar, click Plot.

Evaluation Group: Normal Stress Response
1 In the Results toolbar, click Evaluation Group.

2 In the Settings window for Evaluation Group, type Evaluation Group: Normal 
Stress Response in the Label text field.

3 Locate the Data section. From the Dataset list, choose 
Transient Study for Viscoelastic Response (Heterogeneous RVE)/

Parametric Solutions 1 (sol2).

4 From the Parameter selection (para) list, choose First.

5 From the Time selection list, choose Manual.

6 In the Time indices (1-66) text field, type range(21,1,61).

Global Evaluation 1
1 Right-click Evaluation Group: Normal Stress Response and choose Global Evaluation.

Expression Unit Description

solid.cp2.savgXX N/m^2 Average stress, XX direction

Legends

Average normal stress

Expression Unit Description

solid.cp2.savgXY N/m^2 Average stress, XY direction

Legends

Average shear stress
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2 In the Settings window for Global Evaluation, locate the Expressions section.

3 In the table, enter the following settings:

Evaluation Group: Normal Stress Response
1 In the Model Builder window, click Evaluation Group: Normal Stress Response.

2 In the Settings window for Evaluation Group, click to expand the Format section.

3 From the Include parameters list, choose Off.

4 In the Evaluation Group: Normal Stress Response toolbar, click Evaluate.

Evaluation Group: Shear Stress Response
1 In the Results toolbar, click Evaluation Group.

2 In the Settings window for Evaluation Group, type Evaluation Group: Shear Stress 
Response in the Label text field.

3 Locate the Data section. From the Dataset list, choose 
Transient Study for Viscoelastic Response (Heterogeneous RVE)/

Parametric Solutions 1 (sol2).

4 From the Parameter selection (para) list, choose Last.

5 From the Time selection list, choose Manual.

6 In the Time indices (1-66) text field, type range(21,1,61).

Global Evaluation 1
1 Right-click Evaluation Group: Shear Stress Response and choose Global Evaluation.

2 In the Settings window for Global Evaluation, locate the Expressions section.

3 In the table, enter the following settings:

Evaluation Group: Shear Stress Response
1 In the Model Builder window, click Evaluation Group: Shear Stress Response.

2 In the Settings window for Evaluation Group, locate the Format section.

3 From the Include parameters list, choose Off.

Expression Unit Description

t s Time

solid.cp2.savgXX N/m^2 Average stress, XX component

Expression Unit Description

t s Time

solid.cp2.savgXY N/m^2 Average stress, XY component
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4 In the Evaluation Group: Shear Stress Response toolbar, click Evaluate.

Average Normal and Shear Stresses, Evaluation Group: Normal Stress Response, 
Evaluation Group: Shear Stress Response, Stress, Elastic Response, Stress, Viscoelastic 
Response
1 In the Model Builder window, under Results, Ctrl-click to select Stress, Elastic Response, 

Stress, Viscoelastic Response, Average Normal and Shear Stresses, 
Evaluation Group: Normal Stress Response, and Evaluation Group: Shear Stress Response.

2 Right-click and choose Group.

Heterogeneous RVE
In the Settings window for Group, type Heterogeneous RVE in the Label text field.

G L O B A L  D E F I N I T I O N S

Optimization parameters
1 In the Home toolbar, click Parameters and choose Add>Parameters.

2 In the Settings window for Parameters, type Optimization parameters in the Label 
text field.

3 Locate the Parameters section. In the table, enter the following settings:

D E F I N I T I O N S

Variables: Homogenized material
1 In the Model Builder window, under Component 1 (comp1) right-click Definitions and 

choose Variables.

Name Expression Value Description

gg1 0 0 Deviatoric Prony series parameter of 
homogenized material, branch 1

gg2 0 0 Deviatoric Prony series parameter of 
homogenized material, branch 2

gg3 0 0 Deviatoric Prony series parameter of 
homogenized material, branch 3

kg1 0 0 Volumetric Prony series parameter of 
homogenized material, branch 1

kg2 0 0 Volumetric Prony series parameter of 
homogenized material, branch 2

kg3 0 0 Volumetric Prony series parameter of 
homogenized material, branch 3
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2 In the Settings window for Variables, type Variables: Homogenized material in the 
Label text field.

3 Locate the Variables section. In the table, enter the following settings:

M A T E R I A L S

Homogeneous Material
1 In the Model Builder window, under Component 1 (comp1) right-click Materials and 

choose More Materials>Material Link.

2 In the Settings window for Material Link, type Homogeneous Material in the Label text 
field.

3 Select Domain 3 only.

A D D  P H Y S I C S

1 In the Home toolbar, click Add Physics to open the Add Physics window.

2 Go to the Add Physics window.

3 In the tree, select Structural Mechanics>Solid Mechanics (solid).

4 Click Add to Component 1 in the window toolbar.

5 In the Home toolbar, click Add Physics to close the Add Physics window.

S O L I D  M E C H A N I C S :  H O M O G E N E O U S  R V E

1 In the Settings window for Solid Mechanics, type Solid Mechanics: Homogeneous RVE 
in the Label text field.

2 Select Domain 3 only.

Name Expression Unit Description

G_H solid2.D66 Shear modulus of 
homogenized material

K_H solid2.D11-4*G_H/3 Bulk modulus of 
homogenized material

sum_gH gg1+gg2+gg3 Sum of weights

sum_kH kg1+kg2+kg3 Sum of weights

G_H0 G_H/(1-sum_gH) Instantaneous shear 
modulus of homogenized 
material

K_H0 K_H/(1-sum_kH) Instantaneous bulk 
modulus of homogenized 
material
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3 Locate the Structural Transient Behavior section. From the list, choose Quasistatic.

4 Click to expand the Discretization section. From the Displacement field list, choose 
Linear.

Two separate studies are required to compute the homogenized viscoelastic parameters. 
First, apply a unit (engineering) shear strain in order to find the homogenized deviatoric 
Prony series parameters.

Linear Elastic Material 1
1 In the Model Builder window, under Component 1 (comp1)>

Solid Mechanics: Homogeneous RVE (solid2) click Linear Elastic Material 1.

2 In the Settings window for Linear Elastic Material, locate the Linear Elastic Material 
section.

3 From the Material symmetry list, choose Anisotropic.

Viscoelasticity 1
1 In the Physics toolbar, click Attributes and choose Viscoelasticity.

2 In the Settings window for Viscoelasticity, locate the Viscoelasticity Model section.

3 In the table, enter the following settings:

4 Click Add.

5 In the table, enter the following settings:

6 Click Add.

7 In the table, enter the following settings:

Cell Periodicity: Shear Strain Loading
1 In the Physics toolbar, click Domains and choose Cell Periodicity.

2 In the Settings window for Cell Periodicity, type Cell Periodicity: Shear Strain 
Loading in the Label text field.

Branch Shear modulus (Pa) Relaxation time (s)

1 G_H0*gg1 Tau1

Branch Shear modulus (Pa) Relaxation time (s)

2 G_H0*gg2 Tau2

Branch Shear modulus (Pa) Relaxation time (s)

3 G_H0*gg3 Tau3
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3 Locate the Periodicity Type section. From the list, choose Average strain.

4 In the avg table, enter the following settings:

Boundary Pair 1
1 In the Physics toolbar, click Attributes and choose Boundary Pair.

2 In the Settings window for Boundary Pair, locate the Boundary Selection section.

3 Click Clear Selection.

4 Select Boundaries 15 and 20 only.

Boundary Pair 2
1 Right-click Boundary Pair 1 and choose Duplicate.

2 In the Settings window for Boundary Pair, locate the Boundary Selection section.

3 Click Clear Selection.

4 Select Boundaries 16 and 19 only.

Boundary Pair 3
1 Right-click Boundary Pair 2 and choose Duplicate.

2 In the Settings window for Boundary Pair, locate the Boundary Selection section.

3 Click Clear Selection.

4 Select Boundaries 17 and 18 only.

A D D  S T U D Y

1 In the Home toolbar, click Add Study to open the Add Study window.

2 Go to the Add Study window.

3 Find the Studies subsection. In the Select Study tree, select General Studies>

Time Dependent.

4 Find the Physics interfaces in study subsection. In the table, clear the Solve check box for 
Solid Mechanics: Heterogeneous RVE (solid).

5 Click Add Study in the window toolbar.

6 In the Home toolbar, click Add Study to close the Add Study window.

0 0.5*strainFunction(t) 0

0.5*strainFunction(t) 0 0

0 0 0
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D E V I A T O R I C  P R O N Y  S E R I E S  P A R A M E T E R  E S T I M A T I O N  ( H O M O G E N E O U S  

R V E )

1 In the Model Builder window, click Study 2.

2 In the Settings window for Study, type Deviatoric Prony Series Parameter 
Estimation (Homogeneous RVE) in the Label text field.

3 Locate the Study Settings section. Clear the Generate default plots check box.

To get the homogenized viscoelastic parameters, the initial and final elastic responses of 
the heterogeneous RVE can be neglected. This means that the interesting time range is 
from 0.001 s to 10 s.

Step 1: Time Dependent
1 In the Model Builder window, under 

Deviatoric Prony Series Parameter Estimation (Homogeneous RVE) click 
Step 1: Time Dependent.

2 In the Settings window for Time Dependent, locate the Study Settings section.

3 In the Output times text field, type 10^{range(-3,0.1,1)}.

Parameter Estimation
1 In the Study toolbar, click Optimization and choose Parameter Estimation.

2 In the Settings window for Parameter Estimation, locate the Experimental Data section.

3 From the Data source list, choose Result table.

4 From the Result table list, choose Evaluation Group: Shear Stress Response.

5 Locate the Column Settings section. In the table, click to select the cell at row number 2 
and column number 1.

6 In the Model expression text field, type comp1.solid2.cp1.savgXY.

7 In the Unit text field, type N/m^2.

8 Locate the Parameters section. Click Add three times.
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9 Row by row, select the parameter name in the first column, then set the corresponding 
initial value, scale, and bounds as follows:

10 Locate the Parameter Estimation Method section. From the Method list, choose 
Levenberg-Marquardt.

Solution 5 (sol5)
1 In the Study toolbar, click Show Default Solver.

2 In the Model Builder window, expand the Solution 5 (sol5) node.

3 In the Model Builder window, expand the 
Deviatoric Prony Series Parameter Estimation (Homogeneous RVE)>Solver Configurations>

Solution 5 (sol5)>Optimization Solver 1 node, then click Time-Dependent Solver 1.

4 In the Settings window for Time-Dependent Solver, click to expand the Time Stepping 
section.

5 Select the Initial step check box. In the associated text field, type 5e-5.

6 In the Study toolbar, click Compute.

R E S U L T S

Average Shear Stress
1 In the Home toolbar, click Add Plot Group and choose 1D Plot Group.

2 In the Settings window for 1D Plot Group, type Average Shear Stress in the Label text 
field.

3 Locate the Data section. From the Dataset list, choose 
Deviatoric Prony Series Parameter Estimation (Homogeneous RVE)/Solution 5 (sol5).

4 Locate the Plot Settings section.

Parameter name Initial value Scale Lower 
bound

Upper 
bound

gg1 (Deviatoric Prony series 
parameter of homogenized material, 
branch 1)

g1 1 0 1

gg2 (Deviatoric Prony series 
parameter of homogenized material, 
branch 2)

g2 1 0 1

gg3 (Deviatoric Prony series 
parameter of homogenized material, 
branch 3)

g3 1 0 1
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5 Select the y-axis label check box. In the associated text field, type Average shear 
stress (N/m<sup>2</sup>).

6 Locate the Title section. From the Title type list, choose Manual.

7 In the Title text area, type Global: Average shear stress (N/m<sup>2</sup>) .

8 Locate the Axis section. Select the x-axis log scale check box.

Global 1
1 Right-click Average Shear Stress and choose Global.

2 In the Settings window for Global, locate the y-Axis Data section.

3 In the table, enter the following settings:

4 Locate the Legends section. From the Legends list, choose Manual.

5 In the table, enter the following settings:

Global 2
1 Right-click Global 1 and choose Duplicate.

2 In the Settings window for Global, locate the Data section.

3 From the Dataset list, choose 
Transient Study for Viscoelastic Response (Heterogeneous RVE)/

Parametric Solutions 1 (sol2).

4 From the Parameter selection (para) list, choose Last.

5 From the Time selection list, choose Interpolated.

6 In the Times (s) text field, type 10^{range(-3,0.1,1)}.

7 Locate the y-Axis Data section. In the table, enter the following settings:

8 Click to expand the Coloring and Style section. Find the Line markers subsection. From 
the Marker list, choose Point.

9 Find the Line style subsection. From the Line list, choose None.

Expression Unit Description

solid2.cp1.savgXY N/m^2 Average stress, XY direction

Legends

Homogenized material model

Expression Unit Description

solid.cp2.savgXY N/m^2 Average stress, XY direction
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10 Locate the Legends section. In the table, enter the following settings:

11 In the Average Shear Stress toolbar, click Plot.

Duplicate the Viscoelasticity and Cell Periodicity features to set up a normal strain load case 
in order to compute the homogenized volumetric Prony series parameters. Use the 
homogenized deviatoric Prony series parameters obtained in the previous optimization 
study in the new Viscoelasticity feature.

S O L I D  M E C H A N I C S :  H O M O G E N E O U S  R V E  ( S O L I D 2 )

Viscoelasticity 2
1 In the Model Builder window, under Component 1 (comp1)>

Solid Mechanics: Homogeneous RVE (solid2)>Linear Elastic Material 1 right-click 
Viscoelasticity 1 and choose Duplicate.

2 In the Settings window for Viscoelasticity, locate the Viscoelasticity Model section.

3 From the Viscoelastic strains list, choose Volumetric and deviatoric.

4 In the table, enter the following settings:

5 Click Add.

6 In the table, enter the following settings:

7 Click Add.

8 In the table, enter the following settings:

Legends

Heterogeneous RVE

Branch Bulk modulus (Pa) Shear modulus (Pa) Relaxation time (s)

1 K_H0*kg1 G_H0*
withsol('sol5',
gg1)

Tau1

Branch Bulk modulus (Pa) Shear modulus (Pa) Relaxation time (s)

2 K_H0*kg2 G_H0*
withsol('sol5',
gg2)

Tau2

Branch Bulk modulus (Pa) Shear modulus (Pa) Relaxation time (s)

3 K_H0*kg3 G_H0*
withsol('sol5',
gg3)

Tau3
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Cell Periodicity: Normal Strain Loading
1 In the Model Builder window, right-click Cell Periodicity: Shear Strain Loading and choose 

Duplicate.

Apply a unit step in the normal strain.

2 In the Settings window for Cell Periodicity, type Cell Periodicity: Normal Strain 
Loading in the Label text field.

3 Locate the Periodicity Type section. In the avg table, enter the following settings:

A D D  S T U D Y

1 In the Home toolbar, click Add Study to open the Add Study window.

2 Go to the Add Study window.

3 Find the Studies subsection. In the Select Study tree, select General Studies>

Time Dependent.

4 Find the Physics interfaces in study subsection. In the table, clear the Solve check box for 
Solid Mechanics: Heterogeneous RVE (solid).

5 Click Add Study in the window toolbar.

6 In the Home toolbar, click Add Study to close the Add Study window.

V O L U M E T R I C  P R O N Y  S E R I E S  P A R A M E T E R  E S T I M A T I O N  ( H O M O G E N E O U S  

R V E )

1 In the Model Builder window, click Study 3.

2 In the Settings window for Study, type Volumetric Prony Series Parameter 
Estimation (Homogeneous RVE) in the Label text field.

3 Locate the Study Settings section. Clear the Generate default plots check box.

To get the homogenized viscoelastic parameters, the initial and final elastic responses of 
the heterogeneous RVE can be neglected. This means that the interesting time range is 
from 0.001 s to 10 s.

Step 1: Time Dependent
1 In the Model Builder window, under 

Volumetric Prony Series Parameter Estimation (Homogeneous RVE) click 
Step 1: Time Dependent.

strainFunction(t) 0 0

0 0 0

0 0 0
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2 In the Settings window for Time Dependent, locate the Study Settings section.

3 In the Output times text field, type 10^{range(-3,0.1,1)}.

4 Locate the Physics and Variables Selection section. Select the 
Modify model configuration for study step check box.

5 In the tree, select Component 1 (comp1)>Solid Mechanics: Homogeneous RVE (solid2)>

Linear Elastic Material 1>Viscoelasticity 1 and Component 1 (comp1)>

Solid Mechanics: Homogeneous RVE (solid2)>Cell Periodicity: Shear Strain Loading.

6 Right-click and choose Disable.

Parameter Estimation
1 In the Study toolbar, click Optimization and choose Parameter Estimation.

2 In the Settings window for Parameter Estimation, locate the Experimental Data section.

3 From the Data source list, choose Result table.

4 From the Result table list, choose Evaluation Group: Normal Stress Response.

5 Locate the Column Settings section. In the table, click to select the cell at row number 2 
and column number 1.

6 In the Model expression text field, type comp1.solid2.cp2.savgXX.

7 In the Unit text field, type N/m^2.

8 Locate the Parameters section. Click Add three times.

9 Row by row, select the parameter name in the first column, then set the corresponding 
initial value, scale, and bounds as follows:

10 Locate the Parameter Estimation Method section. From the Method list, choose 
Levenberg-Marquardt.

Parameter name Initial value Scale Lower 
bound

Upper 
bound

kg1 (Volumetric Prony series 
parameter of homogenized material, 
branch 1)

0.001 1 0 1

kg2 (Volumetric Prony series 
parameter of homogenized material, 
branch 2)

0.001 1 0 1

kg3 (Volumetric Prony series 
parameter of homogenized material, 
branch 3)

0.001 1 0 1
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Solution 6 (sol6)
1 In the Study toolbar, click Show Default Solver.

2 In the Model Builder window, expand the Solution 6 (sol6) node.

3 In the Model Builder window, expand the 
Volumetric Prony Series Parameter Estimation (Homogeneous RVE)>Solver Configurations>

Solution 6 (sol6)>Optimization Solver 1 node, then click Time-Dependent Solver 1.

4 In the Settings window for Time-Dependent Solver, locate the Time Stepping section.

5 Select the Initial step check box. In the associated text field, type 5e-5.

6 In the Study toolbar, click Compute.

R E S U L T S

Average Normal Stress
1 In the Home toolbar, click Add Plot Group and choose 1D Plot Group.

2 In the Settings window for 1D Plot Group, type Average Normal Stress in the Label 
text field.

3 Locate the Data section. From the Dataset list, choose 
Volumetric Prony Series Parameter Estimation (Homogeneous RVE)/Solution 6 (sol6).

4 Locate the Plot Settings section.

5 Select the y-axis label check box. In the associated text field, type Average shear 
stress (N/m<sup>2</sup>).

6 Locate the Title section. From the Title type list, choose Manual.

7 In the Title text area, type Global: Average normal stress (N/m<sup>2</sup>) .

8 Locate the Axis section. Select the x-axis log scale check box.

Global 1
1 Right-click Average Normal Stress and choose Global.

2 In the Settings window for Global, locate the y-Axis Data section.

3 In the table, enter the following settings:

4 Locate the Legends section. From the Legends list, choose Manual.

Expression Unit Description

solid2.cp2.savgXX N/m^2 Average stress, XX direction
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5 In the table, enter the following settings:

Global 2
1 Right-click Global 1 and choose Duplicate.

2 In the Settings window for Global, locate the Data section.

3 From the Dataset list, choose 
Transient Study for Viscoelastic Response (Heterogeneous RVE)/

Parametric Solutions 1 (sol2).

4 From the Parameter selection (para) list, choose First.

5 From the Time selection list, choose Interpolated.

6 In the Times (s) text field, type 10^{range(-3,0.1,1)}.

7 Locate the y-Axis Data section. In the table, enter the following settings:

8 Locate the Coloring and Style section. Find the Line markers subsection. From the Marker 
list, choose Point.

9 Find the Line style subsection. From the Line list, choose None.

10 Locate the Legends section. In the table, enter the following settings:

11 In the Average Normal Stress toolbar, click Plot.

Evaluation Group: Homogenized Prony Series Parameters
1 In the Results toolbar, click Evaluation Group.

2 In the Settings window for Evaluation Group, type Evaluation Group: Homogenized 
Prony Series Parameters in the Label text field.

3 Locate the Data section. From the Dataset list, choose 
Deviatoric Prony Series Parameter Estimation (Homogeneous RVE)/Solution 5 (sol5).

4 From the Time selection list, choose First.

Legends

Homogenized material model

Expression Unit Description

solid.cp2.savgXX N/m^2 Average stress, XX direction

Legends

Heterogeneous RVE
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Global Evaluation 1
1 Right-click Evaluation Group: Homogenized Prony Series Parameters and choose 

Global Evaluation.

2 In the Settings window for Global Evaluation, locate the Expressions section.

3 In the table, enter the following settings:

Global Evaluation 2
1 Right-click Global Evaluation 1 and choose Duplicate.

2 In the Settings window for Global Evaluation, locate the Data section.

3 From the Dataset list, choose 
Volumetric Prony Series Parameter Estimation (Homogeneous RVE)/Solution 6 (sol6).

4 From the Time selection list, choose First.

5 Locate the Expressions section. In the table, enter the following settings:

Evaluation Group: Homogenized Prony Series Parameters
1 In the Model Builder window, click 

Evaluation Group: Homogenized Prony Series Parameters.

2 In the Settings window for Evaluation Group, locate the Transformation section.

3 Select the Transpose check box.

4 Locate the Format section. From the Include parameters list, choose Off.

5 In the Evaluation Group: Homogenized Prony Series Parameters toolbar, click 
Evaluate.

Expression Unit Description

gg1 Deviatoric Prony series parameter of 
homogenized material, branch 1

gg2 Deviatoric Prony series parameter of 
homogenized material, branch 2

gg3 Deviatoric Prony series parameter of 
homogenized material, branch 3

Expression Unit Description

kg1 Volumetric Prony series parameter of 
homogenized material, branch 1

kg2 Volumetric Prony series parameter of 
homogenized material, branch 2

kg3 Volumetric Prony series parameter of 
homogenized material, branch 3
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Average Normal Stress, Average Shear Stress, Evaluation Group: Homogenized Prony 
Series Parameters
1 In the Model Builder window, under Results, Ctrl-click to select Average Shear Stress, 

Average Normal Stress, and Evaluation Group: Homogenized Prony Series Parameters.

2 Right-click and choose Group.

Homogeneous RVE
In the Settings window for Group, type Homogeneous RVE in the Label text field.
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